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INTRODUCTION 
This Learning Guide will go over how to review PIMS-related Discipline data and how to create the 
Discipline-related templates required for the submission to PIMS. The templates covered in this Learning 
Guide are those from the Discipline Domain and the Location Domain. The following topics will be covered 
during this Webinar: 

• Creating the PIMS Files 

• Reviewing Setup 

• Reviewing Student Incident and Action Records 

• Instructions for Opening the PIMS Files in Microsoft Excel™ 

• The PIMS Templates 

• Questions and Answers 

PLEASE NOTE: All PIMS-related information is based on the latest PIMS manuals and is subject to change 
by the Pennsylvania Department of Education (PDE).  
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CREATING THE PIMS FILES 

Create PIMS Files Screen 
REPORTS > EXPORTS > PA STATE REPORTING 

Select Scheduling Year and New Run 

 
This screen is used to create the eight tab-delimited Discipline and Location Domain files. These files meet 
the specifications outlined in the most recent revision of the PIMS Manual Volume 1 available on the PIMS 
site. 

 
PLEASE NOTE: The process is to be used by any district using Discipline. 

http://www.portal.state.pa.us/portal/server.pt/community/pims-pennsylvania_information_management_system/8959
http://www.portal.state.pa.us/portal/server.pt/community/pims-pennsylvania_information_management_system/8959
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Discipline/Location Fact: This option is used to create the seven Discipline Domain submission files: 
Incident, Person, Incident Offender, Incident Offender Infraction, Incident Offender Disciplinary Action, 
Incident Offender Parent Involvement, and Incident Victim, as well as the one Location Domain 
submission file: Location Fact. 

Date Range/Through: Enter the district’s first day of school in the first Date Range (from date) field. 
The district’s last day of school is entered in the through date field. Alternately, enter 07/01/yyyy as the 
from date and 06/30/yyyy as the through date to encompass the entire school year. 

Run: Select the Run button to create the PIMS Discipline Domain and the PIMS Location Domain 
templates. If errors are detected when the files are being generated, a message will display. Error Reports 
are generated, as needed, to guide data correction or completion. 

IMPORTANT NOTE: Before performing the Create PIMS Files process for subsequent data files, please 
update any required fields, using any Error Reports that have been generated to guide correction or 
completion. 

File Naming Conventions 
File naming conventions follow those mandated by PDE. 

DistrictCode_TargetTable_YYYYMMDDHHMM.csv (example: 100000009_incident_201006051134.tab) 

The first nine digits in the file names are the digits entered as the AUN of the Submitting Agency. 

District Code = 9-digit Administrative Unit Number (for example, 100000009) 

The next portion of the file name is specified (for each file layout) in the PIMS User Manual - Volume 1 
available on the PIMS site. 

Target Table (located on template) e.g., ‘INCIDENT’ 

The next portion of the file name represents the four-digit year (YYYY), the two-digit month (MM), and the 
two-digit day (DD), followed by the hour and minute (military time-24 hour clock) when the file was 
created (HHMM). 

Time Stamp (ensures uniqueness for the file) e.g., ‘200709051134’ 

The last part of the file is the file extension. 

File Extension (data separator type) e.g., tab for tab separated 

NOTE: Be sure to retrieve the appropriate file(s) when you are ready to submit the information to PDE via 
the ePDE Web Portal. 



PIMS Safe Schools Submission 

Revised: 05/06/2013 ©2013 Central Susquehanna Intermediate Unit, USA Page 4 

REVIEWING SETUP 

Discipline Incident Types 
SYSTEM > DISCIPLINE/DISCIPLINE INCIDENT TYPE 

 
After the selection of this menu path, the Discipline Incident Types load. The Discipline Incident Types that 

have the keystone icon ( ) in the State Reporting Type column above are PIMS Infraction codes and 
have been preloaded for the district. No state defined codes may be added or deleted by the district. In 
addition, the Code and the Name on State Report of any state code may not be changed, but the 
Discipline Incident Type and Description fields may be altered for local purposes. As state codes are 
changed or added by PIMS, the state defined Incident Types will be updated by the CSIU. 

NOTE: Only Incident Types defined as state codes will be reported to PIMS as infractions. Please keep this 
in mind, as it will become important when entering discipline records for students. 
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Discipline Action Types 
SYSTEM > DISCIPLINE/DISCIPLINE ACTION TYPE 

Select Discipline Action Type from the Discipline Type drop-down. 

 

The Discipline Action Types that have the keystone icon ( ) in the State Reporting Type column are 
PIMS Sanction codes and have been preloaded. No state defined codes may be added or deleted by the 
district. In addition, the Code of any state code may not be changed, but the Discipline Action Type and 
Description fields may be altered for local purposes. As state codes are changed or added by PIMS, the 
CSIU will update the state defined Action Types. 

 

Action Types may be mapped to PIMS Sanctions using the State Code field. 
This should only be done when the district wishes to equate a locally defined 

action type with a PIMS Sanction. 

NOTE: Only Action Types defined as state codes will be reported to PIMS as sanctions. Please keep this in 
mind when associating locally defined Action Types with PIMS Sanctions. 

State Code - This drop-down is populated by PIMS Sanction codes. Associate the action type with a PIMS 
Sanction code if desired. Please keep in mind that if a state code is associated with an action, that action 
is eligible to be reported to PIMS. 

If the district allows staff to assign actions to local incidents (i.e. a teacher's personal detention) and the 
action they use is associated with a State Code, the teacher's personnel detention will not be reported as 
a disciplinary action to PIMS. This is because the incident code in this case is not defined by the state. To 
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avoid confusion, it is good practice to define local action codes with no associated state code and instruct 
staff as to which they are to use for their personal purposes. 

REVIEWING STUDENT INCIDENT AND ACTION RECORDS 
The primary method for reviewing incident and action records for students is to use the STUDENT > 
DISCIPLINE > DISCIPLINE ENTRY WIZARD. This method was designed for administrative staff that is 
responsible for the PIMS submissions and tracking information like hearings, victims, actions. It is the 
method being covered in this Learning Guide. 

A second method that can be used is STUDENT > PROFILE > DISCIPLINE. It was designed for 
teachers or staff to use and can be accessed wherever the student Profile is available (class rosters, 
attendance, etc.). This method will not be covered in this Learning Guide. 

Discipline Entry Wizard 
STUDENT > DISCIPLINE > DISCIPLINE ENTRY WIZARD 

The discipline information entered on this screen is comprehensive and can be of a sensitive nature. It is 
recommended that only those who are responsible for the administration and recording of student 
disciplinary actions and the PIMS submission access this screen. Security may be configured to allow a 
broader spectrum of users if the district desires. 

Searching for Existing Incidents 
Student and staff are driven by building. Make sure the correct building is selected in the School Selection 
drop-down in the upper right corner of the screen. 

 
The Search Existing Incidents button displays all existing incidents that match the search criteria. This 
button is useful for quickly locating incident records that may have been entered by a staff member and 
require more information or for viewing all incidents for a particular offender or of a specified Incident 
Type. 

The Edit ( ) icon is used to open the exiting Incident record. 
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Incidents 
STUDENT > DISCIPLINE > DISCIPLINE ENTRY WIZARD/INCIDENT 

 
Fields marked with a red asterisk (*) are required. 

Incident ID - This will be a unique id generated by the system when the record is saved. 

Incident Category - Select the incident category. The entries for this drop-down are supplied by 
SYSTEM > DISCIPLINE/DISCIPLINE INCIDENT TYPE. 

NOTE: If the Incident Category selected is a state defined code (i.e. PIMS Infraction), the incident will 
be reported to PIMS, and all offenders added to this incident record will be reported as having committed 
that infraction to PIMS. If this is not the desired outcome, add a local Incident Category that will not be 
reported to PIMS and then assign infractions to individual offenders that will be reported to PIMS. Adding 
Infractions to individual offenders is discussed in more detail below. 

Referred By - Select the staff member that reported the incident or type a name in the text box under 
the drop-down list. 

Incident Description - Enter a brief description of the incident. 

Time of Day - Select During Regular School Hours or Before or After School Regular Hours. 

Incident Date - Enter the date the incident occurred. 

Context - Select any of the applicable incident contexts. 

Publish to Portal - Select this option to publish the incident on the parent portal so that this information 
is available to the parents of the offenders online. 

School - Select the school in which the incident occurred or for which it is to be reported. 

Location - Enter where the incident took place (these are the PIMS Incident Place codes). 

Specify Location - Enter the specific location the incident took place that is meaningful to the district. 
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Incident Details - Enter any details about the incident the district would like to record (limit 2000 

characters). Click the ( ) icon to run spell check for this field. 

Incident Time - Enter when the incident took place. 

Number of Student Victims - Enter the number of victims. 

Infractions 

Select the Edit ( ) icon next to an existing infraction to modify the selected infraction. 

Select the (Add Infraction) that is located at the right side of the Infractions section to enter new or 
additional infractions. 

Click the  (Assign Offenders) that is located at the right side of the Infractions section to assign 
new or additional offenders to the infraction. 

 
Adding an Infraction to an incident record is useful if a student has committed several infractions that 
need to be separately defined or if there are multiple offenders that have committed different infractions 
related to an incident. 
NOTE: the Infraction drop-down is populated with the same entries as the Incident Category field but 
the terminology was changed here to represent the specificity of how this field is to be used especially in 
the case of multiple offenders. However, if a state defined infraction is selected, it will not be reported to 
PIMS unless the Incident Category is also state defined. 

This is why it is a good idea to have locally defined Discipline Incident Types in SYSTEM > 
DISCIPLINE/DISCIPLINE INCIDENT TYPE that are general enough to account for scenarios where 
there might be multiple offenders committing a mix of state defined and locally defined incidents. An 
example of such an Incident Type might be "Unique Primary Infractions" that could be used when an 
incident contains multiple offenders with different infractions assigned to them. 

Actions 
STUDENT > DISCIPLINE > DISCIPLINE ENTRY WIZARD/ACTIONS 

Click the Actions button to display the Actions screen. 

  

Select the Edit ( ) icon next to an existing action to modify the action. 
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Select the (Add Action) that is located at the right side of the Actions section to add an action record. 

 
Fields marked with a red asterisk (*) are required. 

Disciplinary Action Type - Select the action type. The entries for this drop-down are supplied by 
SYSTEM > DISCIPLINE/DISCIPLINE ACTION TYPE. 
NOTE: If the Disciplinary Action Type selected is a state defined code (i.e. PIMS Sanction) the action 
will be reported to PIMS as long as the incident is reportable to PIMS. If the action type is locally defined, 
but has been associated with a state code in SYSTEM > DISCIPLINE/DISCIPLINE ACTION TYPE, it 
will also be reported to PIMS. This is why it is important to give careful consideration to linking locally 
defined actions with state defined actions. 

Action Details - Enter details of the action. Click the ( ) icon to run spell check for this field. 

Begin/End Date - Enter the beginning and ending date for the duration of the action. If the Action 
Status is 'Permanent' the end date is not required. 

Number of Days - Enter the duration of the action in days. 

Receiving Educational Service - Select this option if the offender is receiving educational services. 

Offender - This box displays all offenders. To assign this action to one or specific offenders, click on the 
offender name or hold down the CTRL button and click on specific offenders. Any offenders not selected 
will not be assigned the action. 

Authority/Authority Name - Select a predefined authority from the authority field. This selection will 
populate the Authority Name field based on the SYSTEM > DISCIPLINE/DISCIPLINE AUTHORITY 
screen. While Authority is a required field, Authority Name is not. Therefore, it is permissible to let this 
field blank. 
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Police Notified - Select this checkbox to indicate that police were notified and to display the 
Precinct\LLE, Central Complaint Number, Arrest, and Adjudication fields. 

 
Precinct\LLE - Enter the name of the law enforcement agency notified. 

Central Compliant Number - Enter if known. 

Arrest - Enter the arrest code if known. 

Adjudication - Enter the adjudication if known. 

Parent Contacted - Select this box if the offender's parents were notified of the incident. If this option is 
checked, the Name of Parent/Guardian and Parent Notified By fields are both required. 

Name of Parent/Guardian - Enter the name of the person notified. 

Parental Notification Date - Enter the date the parent was notified. 

Description - Enter a brief description of the action. 

Action Status - Select 'Temporary' or 'Permanent' to categorize the duration of the action. 

Room - Enter the room where the disciplinary action will be enforced. For example, if detention is held in 
room 211, enter 211 here. 

Offender Response - Enter the offender's response if applicable. Click the ( ) icon to run spell check 
for this field. 

Parent Notified By - Select the method of parent notification. 

Description - Enter a description of the parent notification if desired. 
NOTE: If the Parent Notified By selection is ‘NA’ and the Action will be reportable to PIMS, an entry must 
be made in the Description field to report method by which parents were notified. 

Publish To Portal - Select this option to publish the action on the parent portal so that this information is 
available to the parents of the offenders online. 

Select  (Assign Days Served) to display a new screen on which days can be assigned for 
the action to be served. 

 
Once the Save button is clicked, a new button appears on the screen to Add Next Date. Clicking this 
button will add the next date up to until you reach the End Date established earlier for the Action. 
NOTE: Since the Add Next Date button does not look at the schools calendar, be sure that you do not 
accidentally add dates that are not school days, such as Saturdays, Sundays, holidays, etc. 
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After the dates have been entered, you can click the Edit ( ) icon next to a date to record the Status. 
The available statuses are: Assigned, Not Served, Completed, Absent, and Excused. 

Offenders 
STUDENT > DISCIPLINE > DISCIPLINE ENTRY WIZARD/OFFENDERS 

Click the Offenders button to display the Offenders screen. 

  

Select the Edit ( ) icon next to an existing offender to modify the offender information. 
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The Edit Offender screen displays. Fields marked with a red asterisk (*) are required. 

Teacher Comment - Enter any comments from the teacher reporting the incident if applicable. 

Teacher Recommendation - Select a teacher recommendation. 

Offender Response - Enter the offender's response if applicable. 

Weapons Used - Select the type of weapon used if the incident involved a weapon. 

Weapons Detection - Enter the method used to detect the weapon. 

Number of Weapons - Enter the number of weapons used. 

Weapons Detection Comments - Enter any comments about the weapon's detection. 
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Select the (Add Offender) that is located at the right side of the Offenders section to add an offender. 

  
There are four buttons at the top right of the screen Select Student, Select Staff, Select Person, and 
Close. The first three buttons allow the entry of different types of offenders and access different screens.  

Select Students 
When the page loads, the Select Student screen loads by default. This screen allows users to search for 
students within the district. 

Enter any search criteria and click the Search button. Two boxes will display at the bottom of the screen.   

 
The "Available People" box contains all students that meet the search criteria. To select a student, click on 
the student's name and it will be transferred to the "Selected People as Offenders" box. The student's 
name will then turn red in the "Available People" box to indicate that student is selected. After the 
offenders have been selected, click the Save and Add Response button to add an offender record. If 
multiple students are selected, multiple offender records will be created. 
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Select Staff 
To add a staff member as an offender, click the Select Staff button. 

Enter any search criteria and click the Select button. Two boxes will display at the bottom of the screen. 

 
The method for adding a staff member as an offender is the same as adding a student from this point. 

Select Person 
Click the Select Person button to add an offender record for anyone who is not a student or staff 
member at the district. This includes students from other schools and parents. 

 
Notice that the Add Other Person button is now available. If the person has already been entered using 
this screen, enter the person's name and criteria and click Search. If the person has not previously been 
reported as an offender, click the Add Other Person button. 

 
Fields marked with a red asterisk (*) are required. 

First/Middle/Last Name - Enter the person's name. 

Gender - Select the gender. 

Date of Birth/Age - Enter either Date of Birth or Age if desired.  
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Race - Select the person's race if known. If the race unknown, select "Unspecified". 

District - Enter the school or district that the person is from if the person is a student from a different 
school district. 

Person Type - Select the person type the best categorizes this offender. 

After all required fields are entered, click the Save button to add the person as an offender. This person 
will then be stored in the database and may then be searched for if they are a repeat offender. 

Edit Person 
After an Other Person type person has been added as an offender, click the (Edit Other Person) icon to 
edit the person’s information 
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Victims 
STUDENT > DISCIPLINE > DISCIPLINE ENTRY WIZARD/VICTIMS 

Click the Victims button to display the Victims screen. 

  

Select the Edit ( ) icon next to an existing offender to modify the victim information. 

 
The Edit Victim screen displays. Fields marked with a red asterisk (*) are required. 

Student Assistance Program Referral - Select this option if the victim was referred to a student 
assistance program. 

Medical Treatment Required - Select this option if the victim required medical treatment. 

Victim Response - Enter the victim's response. Enter N/A if not applicable. 

Injury Severity - Select an injury severity. 

Comments - Enter any comments about the victim. 

Select the (Add Victim) that is located at the right side of the Victims section to add a victim. 

NOTE: Since the Add Victim icon works like the Add Offender option, please refer to that section of this 
Learning Guide for how to use it. 
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Hearings 
STUDENT > DISCIPLINE > DISCIPLINE ENTRY WIZARD/HEARINGS 

The Hearing button allows the district to record any disciplinary hearings that resulted from an incident. 
PIMS does not collect hearing information at this time so this information is only recorded for local 
purposes. 

Staff cannot enter hearing information from the student profile. This screen is the only place 
where hearing information may be added. 

  

Select the Edit ( ) icon next to an existing offender to modify the hearing information. 

  

Select the (Add Hearing) that is located at the right side of the Hearings section to add a hearing 
record  

Since multiple offenders and actions may exist, users have the ability to select the Offender and the 
Action that resulted in a hearing. There must be at least one offender and action record before a hearing 
record may be added. 

Fields marked with a red asterisk (*) are required. 

Hearing Date - Enter the date of the hearing. 

Time - Enter the time of the hearing. 

Location - Enter the location of the hearing. 

Hearing Officer - Enter the name of the person who presided over the hearing. 

Details - Enter any details about the hearing (up to 4000 characters). 
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Select the Edit ( ) icon next to an existing district or offender representative to modify the 
representative’s information. 

Click the ( ) icon next to the appropriate heading to add additional district or offender representatives 
that were present at the hearing. 

 
Fields marked with a red asterisk (*) are required. The fields are the same for both the district and 
offender representative. The only difference is the preloaded entries that populate the Type drop-down. 

Representative - Enter the name of the district/offender's representative. 

Type - Select a type that best categorizes the representative's relationship to the district/offender. The 
fields that populate this drop-down are preloaded and differ depending on the representative's affiliation 
(district or offender). 

The Finish Button 
STUDENT > DISCIPLINE > DISCIPLINE ENTRY WIZARD/FINISH 

Click the Finish button to return to the Search Offenders screen. The Finish button cannot be clicked when 
a second window is open (e.g. hearing, victims, etc.). 
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View Incident 
STUDENT > DISCIPLINE > DISCIPLINE ENTRY WIZARD/VIEW INCIDENT 

Click View Incident to display details about the incident, action, offender, victim, and hearings. This 
screen may also be used to assign actions to offenders. A printer icon is also available for printing the 
incident. 

 

Discipline Report Wizard 
STUDENT > DISCIPLINE > DISCIPLINE REPORT WIZARD 

The Discipline Report Wizard can be used to create reports containing selected incidents and actions. This 
report wizard can be run at the District level or the Building level. 

Offender/Victim Information 

 
Use this tab to select the students to be included on the reports. Leaving the options with the default 
settings will return incidents and actions for all students for either the district or building, depending on 
the School selection. 
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Click the Next button to enter discipline incident options. 

Discipline Incident Options 

 
Use this tab to select the incidents to be included on the reports. 

NOTE: Select State Reportable Incidents only and enter the full school year (ex. From 07/01/2011 To 
06/30/2012) in order to include all incidents that are currently indicated to be reportable to PIMS for the 
entire school year on the reports 

Click the Next button to enter discipline infraction options. 

Discipline Infraction Options 

 
Use this tab to select the incidents to be included on the reports. 

Click the Next button to enter discipline action options. 
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Discipline Action Options 

 
Use this tab to select the actions to be included on the reports. This tab is also used to indicate the reports 
to be generated. 
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INSTRUCTIONS FOR OPENING THE PIMS FILES IN EXCEL™ 
Please follow the steps below to open the PIMS files in Microsoft® Excel™ 2010. 

IMPORTANT NOTE: If any of the PIMS templates are opened in Excel, DO NOT save them as Excel files. 
The original file template is formatted SPECIFICALLY for submitting to PDE. Use Excel primarily to review 
the data. If Excel is used to make corrections, be sure to follow the instructions in the Guide to 
Manipulating Data (located on the PDE PIMS website at PIMS Documents > PIMS How to Guides & 
Training Docs) to save the data in the appropriate format. We STRONGLY RECOMMEND that users first 
make a copy of the PIMS file for backup purposes; then follow these steps: 

Reviewing the PIMS Data Using Excel 
1. Open Excel. 

2. From the Data menu, select From Text. An Import Text File window displays. 

3. Navigate to the copy of the PIMS file. 

4. Select the file and click Import. A Text Import Wizard will appear. 

5. Using the Text Import Wizard, perform the following three sub-steps:  
Step One - Select Delimited as the Original data type, leave the other options as the default 
settings, and then click Next. 
Step Two - Select Comma as the Delimiter and the double quotation mark (“) as the Text qualifier. 
Click Next. 
Step Three: 
a) Select all of the columns in the Data preview area. Be sure the first column is selected, scroll to 
the last column, hold down the SHIFT key, and click the last column. 
b) Select Text as the Column data format and click Finish. 

6. On the Import Data window that appears select either Existing worksheet with =$A$1 as the 
location. 

7. The data in the selected template file will import into the worksheet. 

8. Use the PIMS Template Tables, below, to review the data. 

Saving the PIMS Data Using Excel 
If changes had to be made to the file, please follow the steps below to save the modified file in a format 
that can be submitted to PIMS: 

1. From the File menu, select Save As…. 

2. Change the File Type selection to CSV (Comma delimited) (*.CSV). 

3. To ensure that the correct name is used, locate the file you used for importing the data and select 
it. This will give the file the same name. It is recommended that you save the file in a different 
location, so as not to replace the original file. 

4. Click Save. 

5. Click "OK" to the message that appears asking if you want to save only the active sheet. 

6. Click "Yes" to the message that appears asking if you want to keep the formatting. 

7. Close the file - You may be asked to save the file again and asked if you want to keep the format, 
click "Yes" to both. 

8. The file can now be submitted to PIMS. 
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THE PIMS TEMPLATES 

Discipline Domain 
Incident Template 
Target Table: INCIDENT 

Excel 
Column 

PIMS 
Field PIMS Field Name CSIU Student Information System R/O/CR 

A 1 Submitting District Code System > Registration \ District of 
Responsibility: AUN of District set as Current 
District 

R 

B 2 School Year Date End Date of selected Scheduling Year R 

C 3 Incident ID Discipline Incident ID R 

D 4 Incident ID Date Discipline Incident Date R 

E 5 Location Code of 
Incident 

The PDE School # assigned to Discipline 
Incident School 

R 

F 6 Local Incident ID Not included O 

G 7 Incident Place Code Discipline Incident Location R 

H 8 Incident Time Frame 
Code 

Determined by Discipline Incident Time of 
Day and Time 

CR 

I 9 Incident Against 
Property Indicator 

Will be reported as True for only the following 
Incident Category Codes: 30, 31, 32, and 33 

R 

J 10 Not collected 

K 11 Not collected 

L 12 Not collected 

M 13 Not collected 

N 14 Not collected 

O 15 Not collected 

P 16 Not collected 

 

NOTES: 

Local Incident ID (Field #6): Since this field is optional, we are not including it in the template. 

Incident Time Frame Code (Field #8): Required if Incident Place Code = 1 (on school property/grounds). 



PIMS Safe Schools Submission 

Revised: 05/06/2013 ©2013 Central Susquehanna Intermediate Unit, USA Page 24 

Person Template 
Target Table: PERSON 

Excel 
Column 

PIMS 
Field PIMS Field Name CSIU Student Information System R/O/CR 

A 1 Submitting District Code System > Registration \ District of 
Responsibility: AUN of District set as Current 
District 

R 

B 2 Person ID System automatically assigns to person when 
first entered as either an Offender or a Victim 

R 

C 3 School Year Date End Date of selected Scheduling Year R 

D 4 Person District Code AUN entered in District field when an Other 
Person type is added as either an Offender or 
Victim 

 

CR 

E 5 Student ID Student>Profile>Registration>State ID 
Number 

CR 

F 6 Local Person ID Not included O 

G 7 First Name For Student Type Persons: 
Registration>Student: First Name 

For Staff Type Persons: 
System > Staff > Staff: First Name 

For Other Persons: 
First Name entered when an Other Person 
type is added as either an Offender or Victim 

 

CR 

H 8 Last Name For Student Type Persons: 
Registration>Student: Last Name 

For Staff Type Persons: 
System > Staff > Staff: Last Name 

For Other Persons: 
Last Name entered when an Other Person 
type is added as either an Offender or Victim 

 

CR 

I 9 Race or Ethnicity Code For Student Type Persons: 
Registration>Student: Race 

For Staff Type Persons: 
System > Staff > Staff: Race 

For Other Persons: 
Race selected when an Other Person type is 
added as either an Offender or Victim 

 

CR 
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J 10 Gender Code For Student Type Persons: 
Registration>Student: Gender 

For Staff Type Persons: 
System > Staff > Staff: Gender 

For Other Persons: 
Gender selected when an Other Person type 
is added as either an Offender or Victim 

CR 

NOTES: 

Person District Code (Field #4): Only required if the person (offender or victim) is currently enrolled in an 
LEA other than where the incident took place. 

Student ID (Field #5): Since this field is only required for offenders who are current students, it will not be 
submitted for current students who are only victims. 

Local Person ID (Field #6): Since this field is optional, we are not including it in the template. 

First Name (Field #7): Required for offenders only and will not be submitted for persons who are Victims 
only. 

Last Name (Field #8): Required for offenders only and will not be submitted for persons who are Victims 
only. 

Race or Ethnicity Code (Field #9): Only required if known. 

Gender Code (Field #10): Only required if known. 
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Incident Offender Template 
Target Table: INCIDENT_OFFNDR 

Excel 
Column 

PIMS 
Field PIMS Field Name CSIU Student Information System R/O/CR 

A 1 Submitting District Code System > Registration \ District of 
Responsibility: AUN of District set as Current 
District 

R 

B 2 Incident ID Discipline Incident ID R 

C 3 Offender ID ID on Offender record R 

D 4 School Year Date End Date of selected Scheduling Year R 

E 5 Offender Type Mapped based on Type of person entered as 
an offender, as well as, other statuses 
attributed to a Student or Other Type person. 
(See Notes below) 

R 

F 6 Age at Time of Incident Will be calculated for Student Type Persons, 
not submitted for Staff Type Persons, and as 
entered in the Age field for Other Type 
Persons 

CR 

G 7 Grade Level Code at 
Time of Incident 

Only reported for Student Type Persons CR 

H 8 LLE Notified Indicator Reported as ‘Y’ if the Police Notified option is 
selected on any of the Offender’s assigned 
Actions for the Incident 

R 

I 9 Name of LLE Contacted Precinct/LLE entered on assigned Action for 
the Incident 

CR 

J 10 Arrested Code Arrest selected on assigned Action for the 
Incident 

R 

K 11 Adjudication Code Adjudication selected on assigned Action for 
the Incident 

CR 

L 12 Assigned to Alternative 
Education Indicator 

Reported as ‘Y’ if the Offender’s assigned 
Action for the Incident is mapped to a State 
Code of ‘R1’ 

R 

M 13 Weapon Detected 
Method Code 

Weapons Detection selected on Offender 
record 

CR 

N 14 Weapon Detected 
Comment 

Weapons Detection Comments entry on 
Offender record  

CR 
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NOTES: 

Offender Type (Field #5): Here are the mapping guidelines: 

1 (Student) - Will be submitted if the Person Type is Student and the student does not have an IEP 
student Status record or if the Person Type is Other and the selected Person Type is ‘Student’ 

2 (Student with IEP) - Will be submitted if the Person Type is Student and the student does has an IEP 
student Status record or if the Person Type is Other and the selected Person Type is ‘Student with IEP’ 

3 (Student from another school) - Will be submitted if the Person Type is Other and the selected 
Person Type is ‘Student from another school’ 

4 (Parent) - Will be submitted if the Person Type is Other and the selected Person Type is ‘Parent’ 

5 (Adult visitor/intruder) - Will be submitted if the Person Type is Other and the selected Person Type 
is ‘Adult visitor/intruder’ 

6 (District employee) - Will be submitted if the Person Type is Staff or if the Person Type is Other and 
the selected Person Type is ‘District employee’ 

7 (Other or unknown) - Will be submitted if the Person Type is Other and the selected Person Type is 
‘Other or unknown’ 

Age at Time of Incident (Field #6): Required if age is known. 

Grade Level Code at Time of Incident (Field #7): Required if grade is known. 

Name of LLE Contacted (Field #9): Required if the local law enforcement was notified (‘Y’ in Field #8). 

Adjudication Code (Field #11): Required if Arrested Code (Field #10) is ‘YW’ or ‘YN’. 

Weapon Detected Method Code (Field #13): Required if Arrested Code (Field #10) is populated with ‘YW’ 

Weapon Detected Comment (Field #14): Required if Weapon Detected Method Code (Field #13) is ‘5’ 
(Other) 
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Incident Offender Infraction Template 
Target Table: INCIDENT_OFFNDR_INFRACTION 

Excel 
Column 

PIMS 
Field PIMS Field Name CSIU Student Information System R/O/CR 

A 1 Submitting District Code System > Registration \ District of 
Responsibility: AUN of District set as Current 
District 

R 

B 2 Incident ID Discipline Incident ID R 

C 3 Offender ID ID on Offender record R 

D 4 Infraction Code State Code assigned to State Reporting Type 
only Incident Category Codes 

R 

E 5 School Year Date End Date of selected Scheduling Year R 

F 6 Weapon Count Number of Weapons entered on the Offender 
record for the Incident 

CR 

G 7 Infraction Comment Infraction Description for Infraction Codes 
assigned State Codes of ‘16’, ‘41’, or ‘46’ 

CR 

NOTES: 

Weapon Count (Field #6): Required if Infraction Code (Field #4) is between ‘39’ and ‘46’. 

Infraction Comment (Field #7): Required if Infraction Code (Field #4) is ‘16’, ‘41’, or ‘46’. 
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Incident Offender Disciplinary Action Template 
Target Table: INCIDENT_OFFNDR_DSPLNRY_ACTION 

Excel 
Column 

PIMS 
Field PIMS Field Name CSIU Student Information System R/O/CR 

A 1 Submitting District Code System > Registration \ District of 
Responsibility: AUN of District set as Current 
District 

R 

B 2 Incident ID Discipline Incident ID R 

C 3 Offender ID ID on Offender record R 

D 4 Disciplinary Action Code State Code assigned to Disciplinary Action 
Type selection on Action record of 
Incident/Offender 

R 

E 5 School Year Date End Date of selected Scheduling Year R 

F 6 Not collected 

G 7 Not collected 

H 8 Disciplinary Action 
Duration 

Number of Days entered on the Action record 
for the Incident/Offender 

CR 

I 9 Not collected 

J 10 Received Services 
Indicator 

Reported as ‘Y’ if the Receiving Educational 
Service option as selected on the Action 
record for the Incident/Offender 

CR 

K 11 Disciplinary Action 
Comment 

Description entry on the Action record for the 
Incident/Offender 

CR 

NOTES: 

Disciplinary Action Duration (Field #8): Required if Disciplinary Action Code (Field #4) is ‘S3’ – ‘S7’. 

Received Services Indicator (Field #10): Required if Disciplinary Action Code (Field #4) is ‘S5’, ‘S6’, or 
‘S7’. 

Disciplinary Action Comment (Field #11): Required if Disciplinary Action Code (Field #4) is ‘S10’, ‘R9’, or if 
incident involved a firearm and student was not expelled. 
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Incident Offender Parent Involve Template 
Target Table: INCIDENT_OFFNDR_PARENT_INVOLVE 

Excel 
Column 

PIMS 
Field PIMS Field Name CSIU Student Information System R/O/CR 

A 1 Submitting District Code System > Registration \ District of 
Responsibility: AUN of District set as Current 
District 

R 

B 2 Incident ID Discipline Incident ID R 

C 3 Offender ID ID on Offender record R 

D 4 Parental Involvement 
Code 

Parent Notified By selected on assigned 
Action for the Incident 

R 

E 5 School Year Date End Date of selected Scheduling Year R 

F 6 Parental Involvement 
Comment 

Parent Notified By Description entry on the 
Action record for the Incident/Offender when 
the Parent Notified selection is ‘NA’ 

CR 

NOTE: 

Parental Involvement Comment (Field #6): Required if the Parental Involvement Code (Field #4) is ‘6’ 
(Other). 



PIMS Safe Schools Submission 

Revised: 05/06/2013 ©2013 Central Susquehanna Intermediate Unit, USA Page 31 

Incident Victim Template 
Target Table: INCIDENT_VICTIM 

Excel 
Column 

PIMS 
Field PIMS Field Name CSIU Student Information System R/O/CR 

A 1 Submitting District Code System > Registration \ District of 
Responsibility: AUN of District set as Current 
District 

R 

B 2 Incident ID Discipline Incident ID R 

C 3 Victim ID ID on Victim record R 

D 4 School Year Date End Date of selected Scheduling Year R 

E 5 Victim Type Mapped based on Type of person entered as 
an offender, as well as, other statuses 
attributed to a Student or Other Type person. 
(See Notes below) 

R 

F 6 Age at Time of Incident Will be calculated for Student Type Persons, 
not submitted for Staff Type Persons, and as 
entered in the Age field for Other Type 
Persons 

CR 

G 7 Grade Level Code at 
Time of Incident 

Only reported for Student Type Persons CR 

H 8 Student Assistance 
Program Referral 
Indicator 

Reported as ‘Y’ if the Student Assistance 
Program Referral option as selected on the 
Victim record for the Incident 

R 

I 9 Injury Severity Code Injury Severity option as selected on the 
Victim record for the Incident 

R 

J 10 Medical Treatment 
Required Indicator 

Reported as ‘Y’ if the Medical Treatment 
Required option as selected on the Victim 
record for the Incident 

R 

K 11 Not collected 

L 12 Incident Victim 
Comment 

Comments entry on the Victim record for the 
Incident 

CR 
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NOTES: 

Victim Type (Field #5): Here are the mapping guidelines: 

1 (Student) - Will be submitted if the Person Type is Student and the student does not have an IEP 
student Status record or if the Person Type is Other and the selected Person Type is ‘Student’ 

2 (Student with IEP) - Will be submitted if the Person Type is Student and the student does has an IEP 
student Status record or if the Person Type is Other and the selected Person Type is ‘Student with IEP’ 

3 (Student from another school) - Will be submitted if the Person Type is Other and the selected 
Person Type is ‘Student from another school’ 

4 (Parent) - Will be submitted if the Person Type is Other and the selected Person Type is ‘Parent’ 

5 (Adult visitor/intruder) - Will be submitted if the Person Type is Other and the selected Person Type 
is ‘Adult visitor/intruder’ 

6 (District employee) - Will be submitted if the Person Type is Staff or if the Person Type is Other and 
the selected Person Type is ‘District employee’ 

7 (Other or unknown) - Will be submitted if the Person Type is Other and the selected Person Type is 
‘Other or unknown’ 

8 (School/facility) - Will be submitted if the Person Type is Other and the selected Person Type is 
‘School/School Facility’ 

Age at Time of Incident (Field #6): Required if age is known. 

Grade Level Code at Time of Incident (Field #7): Required if grade is known. 

Incident Victim Comment (Field #12): Required if Medical Treatment Required Indicator (Field #10) is ‘Y’. 
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Location Domain 
Location Fact Template 
Target Table: LOCATION_FACT 

Excel 
Column 

PIMS 
Field PIMS Field Name CSIU Student Information System R/O/CR 

A 1 District Code System > Registration \ District of 
Responsibility: AUN of District set as Current 
District 

R 

B 2 Location Code The PDE School # assigned to Discipline 
Incident School 

R 

C 3 Reporting Date End Date of selected Scheduling Year R 

D 4 Category 1 See Notes below R 

E 5 Category 2 See Notes below R 

F 6 Category 3 See Notes below R 

G 7 Category 4 See Notes below CR 

H 8 Not collected 

I 9 Not collected 

J 10 Not collected 

K 11 Not collected 

L 12 Not collected 

M 13 Not collected 

N 14 Measure Type Defaults to ‘COUNT’ R 

O 15 Count See Notes below R 

P 16 Not collected 

Q 17 Not collected 

R 18 Not collected 

NOTES: 

The information for this template includes counts for students who have been assigned Actions that have a 
State Code of ‘S5’, ‘S6’, or ‘S7’ for Expulsions or ‘S4’ for Out of School Suspensions and ‘Academic’ or 
Violation of Student Code of Conduct’ assigned as the Context on the associated Incident record. In 
addition, the template includes counts of students who have been assigned a Student Status of ‘HT’ for 
Habitually Truant. In SYSTEM > CODES > STUDENT STATUS, there is a Habitually Truant status code 
(HT). Assign this status to habitually truant students for PIMS Reporting through REGISTRATION > 
STUDENT > STATUS. 

Category 1 (Field #4): This field will display the highest level description of the aggregated data being 
submitted. Possible values will be ‘TRUANCY’, ‘EXPULSION’, or ‘SUSPENSION’. In addition, if a building 
being reported by the district does not have any reportable incidents, then this field will have ‘INCIDENTS’ 
and the following Category values will all have ‘ZERO’. 
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Category 2 (Field #5): This field will display the second level description of the aggregated data being 
submitted. The values displayed here relate to three different categories - ‘GRADE’, ‘ETHNICITY’, and 
‘GENDER’. 

Category 3 (Field #6): This field will display the third level description of the aggregated data being 
submitted. The values displayed here relate to values for the categories displayed in Category 2 (Field 
#5). The values for the GRADE category are ‘PKA’, ‘PKP’, ‘PKF’, ‘K4A’, K4P’, ‘K4F’, ‘K5A’, K5P’, ‘K5F’, ‘001’, 
‘002’, ‘003’, ‘004’, ‘005’, ‘006’, ‘EUG’, ‘007’, ‘008’, ‘009’, ‘010’, ‘011’, ‘012’, and ‘SUG’. The values for the 
ETHNICITY category are ‘1’, ‘3’, ‘4’, ‘5’, ‘6’, ‘9’, and ‘10’. The values for the GENDER category are ‘M’ or ‘F’. 

Category 4 (Field #7): This field will display the fourth level description of the aggregated data being 
submitted. It only applies to data where Category 1 (Field #4) has either ‘EXPULSION’ or ‘SUSPENSION’. 
The value in this field will be either ‘CONDUCT’ (for Violation of Student Code of Conduct) or ‘ACADEMIC’ 
relating to the Context assigned on the associated Incident record. 

Count (Field #15): This field contains the relevant count. 

For more information regarding the Location Fact template, please consult the Location Domain section of 
the most current PIMS Manual, Volume 1 and ‘Appendix AA – Categories to use in the Location Fact 
Template’ in the most current PIMS Manual, Volume 2. 
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